
Online SRT Tutorials

Supplemental Information
SRTs Overview

This guide is intended to provide educators with additional detailed information about the MCA online testing 
platform (TestNav), tools, question types, test supports, and accommodations covered in the online Student 
Readiness Tools (SRTs) tutorials.

To locate a specific tutorial, press Ctrl + F and enter the tutorial name into the search bar of the Find box. For 
example, if searching for information about the multiple response question type, type “Multiple Response” into 
the search bar of the Find box and hit Enter. The document will jump to that section of the guide, or you may 
have to select the Previous or Next buttons to navigate to the applicable section.

Note: Standard text-to-speech is available throughout the online SRTs for students who want or need audio 
support.

Grade-level SRT Tutorials

The grade-level SRT tutorials are organized by grade and include lessons and practice opportunities relevant to 
the navigation, tools, and question types students may experience on the MCAs. Although the online SRTs are not 
subject specific, each grade-level SRT contains only the tools and question types applicable to the subjects 
students will test in within each grade. The tutorials of the grade-level SRTs are organized into three sections: 
Getting Around, My Tools, and The Questions.

Getting Around Section

This section provides educators with information on how students will navigate through the test and interact with 
the testing platform, TestNav. Educators can familiarize themselves with the tutorials in the Getting Around 
section of the grade-level online SRTs (PearsonAccess Next > Preparing for Testing > Student Readiness Tools > 
Online SRTs) before using the SRTs with students. 

Note: While the functionality is similar, there are some navigation differences between adaptive tests (Reading 
and Mathematics MCAs) and fixed-form tests (Science MCA) that will be addressed in this section.

Navigation

Information on the Gray Bar – Number of Questions

In the online SRTs, the gray bar indicates the grade-level SRT and tutorials section in which the student is 
practicing.

In the online MCAs, the gray bar contains information about the test and the number of questions that 
students can reference during testing.

For Reading and Mathematics MCAs:

· Questions (and for reading, passages) are divided into multiple groups.

http://minnesota.pearsonaccessnext.com/readiness-tools/
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· However, no group numbers appear in the gray bar. Even though the test is broken up into 

multiple groups, TestNav handles the entire adaptive test as just one section and cannot show 
which group of questions a student is on.

· The question number shows the number of questions in the entire test.

For Science MCA:

· The questions and scenarios are divided into four sections. 
· Because the test is a fixed form and questions are pre-selected, the gray bar indicates which 

section the student is in (Section 1–4).
· The question number shows the number of questions in each section, not the entire test.

Information on the Gray Bar – Progress Indicator 

In the online MCAs only, a progress indicator with a completion percentage appears in the gray bar. The 
completion percentage indicates the student’s completion progress as they answer questions. 

For Reading and Mathematics MCAs, the progress indicator shows the student’s progress for the entire test.

For Science MCA, the progress indicator shows the student’s progress for the section. It will start over in 
each section.

Information on the Gray Bar – Volume Control

In the online MCAs only, for most testing devices, a volume control slider is available in the gray bar. 
Students select the audio icon to open the volume control slider to increase or decrease volume. If their 
testing device is muted when the student signs into TestNav, the student can unmute the device using the 
volume control slider.
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Note: The volume control slider is not available for iOS devices. Students can use the device’s volume control 
buttons to adjust the volume. If the testing device is muted when the student signs into TestNav, the student 
can unmute the device using the device’s volume control buttons.

Start Your Test

In the online SRTs, this tutorial contains a short informational video explaining how students will log in to 
the MCAs. However, students will not be able to practice logging in to the SRTs.

In the online MCAs, student directions are the first section of each test. These directions appear after 
students sign in and before they begin each test. Text-to-speech is available for these directions in all 
subjects. 

The Testing Directions: Online contains a transcript of these directions. A transcript and screenshots are also 
provided in the Overview of Student Directions document for reference. Both documents are updated 
annually and are available on the Testing Directions page before test administration (PearsonAccess Next > 
Preparing for Testing > Testing Directions).

Students can navigate between different student directions pages as needed. For reading and mathematics, 
once students navigate past the student directions, they cannot go back to them. For science, the student 
directions are embedded in the first section so students can go back to them throughout the first section as 
needed.

Next and Back Buttons

Students use the Next and Back buttons to move forward and back in the test. New for 2023–24: The Next 
and Back buttons now appear as blue (active) even if the student has not completed the question. If 
students try to go forward or back before answering the current question, they will receive a Must Answer to 
Continue message prompting them to answer the question before moving on.

Some questions have multiple parts, and a message will display if students select the Next or Back buttons 
without answering all parts of the question.

Note: In the online SRTs, students do not need to answer the current question before they can move 
forward or back in the SRTs.

Review and Bookmark

Students can revisit questions they have completed by selecting the Review button to open the review list. 
Within the review list, students can select any unlocked question to go back to and review their answers. 
However, if the current question is not answered, students cannot select or visit another question in the 

http://minnesota.pearsonaccessnext.com/testing-directions/


4 

Navigation 
review list. A message will display if students select a question in the review list without first answering the 
current question. 

Note: In the online SRTs, students are able to review or go to all questions throughout the tutorials. 
However, when students select the Review button in the online MCAs, the review list will show only the 
questions they have already answered and the current question if they have not yet answered it. 

The number shown on the All Questions tab of the review list tells students how many questions they have 
answered. 

The number shown on the Not Answered tab of the review list will always display as zero or one in the test, 
depending if the student has answered the current question or not. 

The Bookmark button lets students mark questions they want to review later.  

When students select the Bookmark button, a blue bookmark appears next to the question on the review 
list.  
The number shown on the Bookmarks tab of the review list tells students how many questions they have 
bookmarked. 

Note: In the online SRTs, the All Questions and Not Answered tabs in the review list will always show the 
number zero, even if students have interacted with a video tutorial or “Try It!” section. Only the Bookmark 
tab number will reflect students’ actions. 

Submit Reading/Math & Submit Science 

In the online SRTs, these tutorials contain short informational videos explaining how students will submit 
their answers for each section or group of questions and how students will submit their test for the 
Mathematics and Reading MCAs and for the Science MCA.  

Completing a Section and Going to a New Section 

In the online MCAs, after students have answered all of the questions in a group or section, they will see a 
review screen. The review screen will vary based on which test students are taking, and the way in which 
students go to the next group of questions or section also varies based on the test students are taking. 

· For the Reading and Mathematics MCAs, students must use the review list to go back to review 
questions. Students use the Next button to automatically go to the next group of questions.  

· For Science MCA, the questions will be listed under the Submit button for review. Students can 
select a question from this list and will be taken directly to the question. Questions that were 
bookmarked by the student will be marked with a bookmark icon. Students use the Submit button 
to go the next section. A section exit warning will pop up. Students select No to go back or select 
Yes to go to the next section.

Once students go on, they cannot return to questions completed previously.

Note: Although the tutorials are organized into different categories, the online SRTs are not divided into
multiple sections or groups, and students can view any tutorial at any time, even those completed 
previously.
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Exiting the Test

In the online MCAs, to exit the test, students will: 

· Select the button next to their name.
· Select Sign out of TestNav in the user dropdown menu.
· Select Save and Return Later.

Note: In the online SRTs, students will select Sign out of TestNav; they will not be able to save their 
responses or mark where they left off in the SRTs.

Completing the Test

In the online MCAs, when students have completed their test, they will see a final review screen. The review 
screen will vary based on which test students are taking.

To submit their test: 

· For the Reading and Mathematics MCAs, students will select Next. Once students select Next, they 
will not be able to go back to their test. Then, students will select Submit Final Answers. 

· For Science MCA, students will first select Submit Final Answers. Then students will select Yes, 
Submit Final Answers. 

Once students submit their test, they will not be able to go back into it.

Note: In the online SRTs, students will be notified when they have completed a set of tutorials and 
prompted to sign out of TestNav. Students are not required to sign out of TestNav, but if they do, they can 
still go back into the SRTs. It is important that students understand the SRTs are not scored.

Inactivity

In the online SRTs, although the inactivity function is not covered in the tutorials, the SRTs will time out after 
20 minutes of inactivity and students will be automatically exited from the tutorial.

In the online MCAs, student tests in TestNav will time out after 20 minutes of inactivity. Inactivity is defined 
as not touching the screen, moving the mouse, and/or pressing keys. 

Students will receive a warning 30 seconds prior to being exited due to inactivity. When they are exited, they 
will also receive a message that the session (their test) has closed due to inactivity. The student’s test will 
need to be resumed in PearsonAccess Next in order for the student to continue testing. 

If students are exited due to inactivity, they still have 20 minutes to resume the test with the ability to go 
back and review previously answered questions. If more than 20 minutes have passed after exiting the test, 
students cannot go back to review their answers.



6 

My Tools Section

This section provides educators with information on the purpose and functionality of the tools students may use 
while testing. Educators can familiarize themselves with the tutorials in the My Tools section of the grade-level
online SRTs (PearsonAccess Next > Preparing for Testing > Student Readiness Tools > Online SRTs) before using 
the SRTs with students.

Students can select tools from the following places: the toolbar, the user dropdown menu, and the right side of 
the screen. Other tools are accessed directly on the question itself.

Tools

Answer Eliminator (Toolbar)

Students can use the answer eliminator tool to cross out an answer choice. It is available only for multiple-
choice and multiple-response questions.

To use this tool, students:

· Select the Answer Eliminator button.
· Select the answer choice or choices they want to cross out.

To remove the X, students select the crossed-out choice again with the answer eliminator tool.

Keyboard shortcuts: When the answer eliminator tool is selected, students can use the Tab key to navigate 
to the answer choices. Once an answer choice is selected, students can use the Tab key and/or the up and 
down arrow keys to navigate through each answer choice. Students press the space bar to cross out an 
answer choice. To remove the X, students press the space bar again. 

Students use the pointer tool to select their answer. The X must be removed before students can select an 
eliminated answer choice as their answer. 

Note: If a student changes the color contrast settings to colors other than the default Black on White, the X 
may also appear in a color that is not red.

Calculator (Toolbar)

Students can use the calculator tool to help them answer questions on their mathematics and science tests. 
It is available only on questions where students are allowed to use it. The calculator available varies by grade 
and subject. Refer to the stand-alone calculators on PearsonAccess Next (PearsonAccess Next > Preparing 
for Testing > Stand-Alone Calculators) to view and practice using the types of calculators available on the 
MCAs. Note: In the grade 8 online SRT, both the basic and graphing calculators are available for practice. 
However, only the basic calculator will appear on the grade 8 Science MCA and only the graphing calculator 
will appear on the grade 8 Mathematics MCA.

To open the calculator, students select the Calculator button. Students can select the buttons on the 
calculator or use the keyboard.

To move the calculator, students select the calculator and drag it. 

Students select the Calculator button again to close the calculator.

http://minnesota.pearsonaccessnext.com/readiness-tools/
http://minnesota.pearsonaccessnext.com/stand-alone-calculators/
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Note: The calculators do not operate with external keyboards on iPads. Students testing on iPads should be 
instructed to operate the calculator using the touchscreen.

Basic calculator 
(TI-108™): 
Grades 3–5 
mathematics 
and all grades 
of science

Scientific 
calculator (TI-
30XS™): Grades 
6 and 7 
mathematics

Graphing 
calculator (TI-84 
Plus CE™): Grades 
8 and 11 
mathematics

Note: The default setting for the 
graphing calculator is Radian. To 
change to Degree, students must 
select MODE, use the arrow keys 
to highlight DEGREE, and then 
select ENTER.

Exhibits (Mathematics Grades 5-8 and 11) (Right side of screen)

Grades 5–8 and 11 mathematics tests have a formula sheet. Refer to the formula sheets on PearsonAccess 
Next (PearsonAccess Next > Preparing for Testing > Formula Sheets) to view the formula sheets that will 
appear in each grade.

To open the formula sheet, students select the Exhibits button.

Students may need to scroll to see all of the formula sheet. To move the formula sheet to a different part of 
the screen, students select the top of the formula sheet and drag it. 

To change the size of the formula sheet, students select and drag the bottom right corner.

To close the formula sheet, students select the Exhibits button again or the X in the upper right of the 
formula sheet.

Note: In the online SRTs, the Exhibits formula sheet cannot be resized.

Highlighter (On Question)

Students can use the highlighter tool to highlight words. 

To use this tool, students select and drag over the words they want to highlight. As they do so, a color-
selection bar will appear over the text, and students can choose the color they wish to use. Once they do so, 
the area will be highlighted. Note: Color choices on the color-selection bar will differ depending on the test’s 
background and foreground colors (color contrast settings).

To remove the highlighting, students re-select the words and choose Unhighlight .

http://minnesota.pearsonaccessnext.com/formula-sheets/
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The Listen button lets students hear text-to-speech for all highlighted word(s). Students may 
select more than one sentence to read aloud. Note: The Listen functionality is similar to Toggle Click-to-Hear, 
but only plays the read aloud for the selected sentence(s).

Note: The highlighter will not highlight the options of hot text questions, which are questions that ask 
students to select boxed selections of text to answer the question. Also, for reading questions in which the 
hot text selections appear in the passage itself, any highlights the student applied to the passage prior to the 
hot text question will be automatically removed. Refer to The Questions subsection of this guide for an 
example of a hot text question type.

Pointer Tool (Toolbar)

Students use the pointer tool to: 

· Select an answer
· Drag an answer choice 
· Mark objects or text
· Turn other tools on and off

Note: The online SRTs do not contain a pointer tool tutorial, although students will use the pointer tool 
throughout the SRTs.

Ruler (Science All Grades) (Toolbar)

In the online SRTs, the ruler is available throughout the entire SRT for students to practice.

In the online MCAs, students see the ruler in the toolbar only on questions where they need to use it.

To use the ruler, students select the Ruler button in the toolbar.

Students then drag the ruler to the place on the object they want to measure. Students can select the 
handles at either end of the ruler to rotate the ruler. 

To close the ruler, students select the Ruler button again.
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Scratchpad (Toolbar)

New for 2023–24: The scratchpad allows students to take notes by typing or drawing. This tool has replaced 
the Notepad.

To use this tool, students select the Scratchpad button from the toolbar. Students can either type their notes 
in the text box or draw in the drawing pane.

To draw, students select Open drawing pane at the bottom of the scratchpad and then select the Draw icon 
to draw or write in the drawing pane. 

To fix mistakes in the drawing pane, students can use the Eraser and Undo/Redo buttons or select the Clear 
pane (trash can) button to clear the pane entirely.

To move the scratchpad, students select the scratchpad and drag it. 

To close the scratchpad, students can either select the Scratchpad button again or select the X in the upper 
right of the scratchpad. Notes save automatically; if students return to the question later, they can see their 
notes again by selecting the Scratchpad button. 

· For reading, notes are saved for the whole passage. 
· For mathematics, notes are saved for each question. 
· For science, notes are saved for each scene or phenomena.

Straightedge (Mathematics Grades 8 and 11) (Toolbar)

In the online SRTs, the straightedge is available throughout the entire SRT for students to practice. In the 
straightedge tutorial video, the question shown contains a hint prompting students to use the straightedge.

In the online MCAs, students see the straightedge in the toolbar only on questions where they are allowed 
to use it. Students are not prompted to use the straightedge tool in the test. 

To use the straightedge, students select the Straightedge button in the toolbar.

To move the straightedge on the screen, students select the blue circles on the ends of the tool and drag 
them. 

To close the straightedge, students select the Straightedge button again.
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White Noise (User Dropdown Menu)

The white noise tool lets students listen to background noise as a way to reduce ambient sound and help 
them focus on the test. There are three white noise sound buttons to choose from: Waves, White Noise, and 
Wind.

On some devices, students can adjust the white noise volume using the on-screen controls. On iPads, the 
volume can be adjusted using the buttons on the side of the device, so students will not see the volume 
control with the other settings.

To turn off the white noise, students can select the Stop button, de-select the specific sound option they 
have chosen (Waves, White Noise, or Wind), or select the X in the upper right on the white noise box. The 
active white noise button is a darker color than the other two options; this button returns to its original 
lighter color once it has been turned off. 

To keep the white noise sound playing but remove the white noise box from the screen, students select the 
minimize button or go back to the dropdown menu and select Close White Noise. Note: Removing the white 
noise box from the screen does not turn off white noise sound. To turn off white noise sound, students must 
select the Stop button, de-select the specific sound option they have chosen, or select the X in the upper 
right on the white noise box.

Note: White noise and text-to-speech negatively affect each other on iPads. Students testing on iPads should 
be instructed to turn off the white noise if using text-to-speech.

The Questions Section

This section provides educators with details on the types of questions students may encounter on the test. 
Educators can familiarize themselves with the tutorials in The Questions section of the grade-level online SRTs
(PearsonAccess Next > Preparing for Testing > Student Readiness Tools > Online SRTs) before using the SRTs with 
students.

Note: Although standard text-to-speech is available for all question types in the online SRTs, students should 
know that reading questions and passages in the online Reading MCA do not have text-to-speech.

Question Types

Bar Graph (Mathematics and Science Only)

Bar graph questions are answered by dragging the top of one or more bars in the bar graph. For some 
questions, students may be able to move only some of the bars.

To change their answer, students drag the top of the bar to move it.

Note: In some bar graph questions, if the bar is dragged too close to the bottom of the graph, it may look as 
if the bar has disappeared. However, the bar is still accessible and can be dragged back up as needed.

http://minnesota.pearsonaccessnext.com/readiness-tools/
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Constructed Response

For constructed response questions, students compose their own answer to the question or prompt by 
entering their response into the text box using the keyboard or touchscreen on their device. Students must 
enter at least one character for the question before they can go to the next question. Students will be scored 
based on their understanding of science concepts and practices, not on grammar, spelling, sentence 
mechanics, or formatting.

· A variety of text formatting options are available within the text box: bold, italics, underline, 
bulleted lists, and numbered lists. Students may use these formatting tools, but they are not 
required.

· The Undo and Redo buttons are available to remove or add back text that was entered or 
formatting that was applied.

· Spell check is available for students to confirm correct spelling if they wish. If the Spell Check 
button is selected, words that may be incorrectly spelled will appear with a red underline. Students 
can select the red underlined word to view suggested spelling corrections.

The response is limited to 1,000 characters (for example, letters, numbers, punctuation, spacing) for all 
constructed response questions.

Responses entered into the text box are automatically saved. Students do not need to take any further 
action before navigating to the next question.
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Drag and Drop 1 (Gap Match) and Drag and Drop 2 (Text Extractor)

Students answer drag and drop questions by dragging an answer choice into the correct box. Answer 
choices may be text or graphics.

While there are different types of drag and drop questions, the functionality is similar across all types of 
questions:

· Some questions let students drag two or more answer choices into the same box, while other 
questions allow only one answer choice in a box.

· In some questions, answer choices can only be dragged into certain boxes.
· In some questions, the same answer choice can be dragged into multiple boxes (that is, it 

replenishes after it is dragged); in other questions, each answer choice can be dragged only one 
time.

When an answer choice is selected and dragged, the boxes into which it can be placed turn blue. To change 
an answer, students need to drag a choice out of the box before they can put another one in.

Text Extractor (Reading Only)

Text extractor questions are a specific type of drag and drop question. Students must drag text selections 
from a passage into boxes to answer the question. Each text selection can only be used one time. To remove 
a selection, students must select the “x” in the upper-right corner of the box or drag a new text selection into 
the box.

Note: In the online SRTs, students will practice dragging text selections from sentences within the question, 
not from within a reading passage because the SRTs are not subject specific. 

Note: Although a text extractor question is shown in the video lesson, grade 3 students will not have a Drag 
and Drop 2 “Try It!” section.

Equation Editor (Mathematics Only)

Students answer equation editor questions by selecting number and symbol buttons on the keypad to fill in 
the answer area.

Depending on the grade and question, different symbols are available on the keypad.

The types of answers students may need to enter include fractions, mixed numbers, equations, and 
expressions.

Only one character needs to be entered into the answer area in order for students to move on in the test. A 
warning message will appear if students try to add more to their answer than is allowed or if they type in a 
character that is not allowed.
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Fill in the Blank (Mathematics and Science Only)

Students answer fill-in-the-blank questions by typing an answer into the text box using the keyboard or 
touchscreen on their device.

For all grades of mathematics:

· Students can answer using digits 0–9, the forward slash (/) to show fractions, and the period (.) to 
show decimals. Note: For some questions, only numbers are allowed.

· Students must change a mixed number to an improper fraction or decimal (as appropriate for the 
question) because a space is not an allowable character.

· For questions with an answer greater than or equal to 1,000, students must enter the answer 
without a comma.

For grades 7, 8, and 11 mathematics, in addition to the digits 0–9, forward slash, and period, students can 
use the hyphen (-) to show negative numbers. 

For science, students can answer using letters A–Z or the digits 0–9, depending on the question. On some 
questions, a hyphen for a negative sign (-) and a period (.) for a decimal are allowable characters. Note: In 
the online SRTs, students will not be able to practice entering letters.

To change or remove their answer, students use the backspace key on the keyboard. They then can enter 
their new answer.
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Function Graph (Mathematics Grade 11 Only)

Students answer function graph questions by selecting one graph type, when prompted, and graphing a 
solution.

Not all graph types are available on all questions. For questions with only one graph type, the graph-type 
button will not display as the coordinates will automatically appear on the graph. In this case, a Reset button 
is available if the function needs to be reset to the original coordinates.

· Linear Functions: Students select the Linear button. A line with two points will appear, and students 
drag each point to the appropriate location on the grid. To remove or reset the linear function, 
students select the Reset (if available) or Linear (if available) button again. 

· Absolute Value Functions: Students select the Absolute Value button. An absolute value function 
with two points will appear. One point is the vertex, and the other is another point on the function. 
Students drag each point to the appropriate location on the grid. To remove or reset the absolute 
value function, students select the Reset (if available) or Absolute Value (if available) button again. 

· Quadratic Functions: Students select the Quadratic button. A quadratic function with two points will 
appear. One point is the vertex, and the other is another point on the function. Students drag each 
point to the appropriate location on the grid. To remove or reset the quadratic function, students 
select the Reset (if available) or Quadratic (if available) button again. 

· Exponential Functions: Students select the Exponential button. An exponential function with two 
points will appear. An asymptote will also appear on the graph as a gray dashed line on the x-axis. 
Students drag the asymptote line up or down to the appropriate location on the grid. Then, 
students drag each point to the appropriate locations on the grid. To remove or reset the 
exponential function, students select the Reset (if available) or Exponential (if available) button 
again.

Note: In the online SRTs, students will be able to practice graphing a linear, quadratic, and exponential 
function.

Fraction Models (Mathematics Only)

Fraction model questions are answered by selecting the More button to divide the model into more parts or 
the Fewer button to divide the model into fewer parts. Students then select the parts they want to shade to 
complete the model. Note: In the online MCAs, for some fraction model questions, the More and Fewer 
buttons are grayed out and students only need to select the parts of the model they want to shade to 
answer the question.

To remove the shading on a part of the model, students select the part again. To start the question over, 
students select the Reset button.
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Hot Spot

Hot spot questions are answered by selecting an object, which may be text or graphics.

There may be more than one answer, so students will select as many objects as needed to answer the 
question.

To change their answer, students select the object(s) again. They then select the new object(s) they want to 
choose.

Depending on the question, an orange warning box will appear if students try to select too many options. 
However, a warning box will not appear if students select too few options, so it is important that students 
read the directions carefully.

Hot Text (Reading Only)

Hot text questions are a specific type of hot spot question. Students answer these questions by selecting 
one or more highlighted selections of the text. 

To change their answer, students select the highlighted text again. They then select the new highlighted text 
they want to choose.

Depending on the question, an orange warning box will appear if students try to select too many options. 
However, a warning box will not appear if students select too few options, so it is important that students 
read the directions carefully.

Inline Choice

Inline choice questions are answered by selecting the answer from one or more dropdown menus. 

To view all of the answer choices, students select the dropdown menu. Students select one answer from 
each dropdown menu.

To change their answer, students select a different answer from the dropdown menu.

Multiple Choice

Multiple choice questions have only one correct answer. These questions have a circle next to each answer 
choice. 

Students answer multiple-choice questions by selecting the answer or the circle to the left. 

Students change their answer by selecting a different answer.
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Multiple Response

For multiple response questions, students should select all of the answers that they think are correct. These 
questions have a square checkbox next to each answer choice. Students select the checkbox to add a 
checkmark to their answer.

Students must read the directions carefully before answering the question so they know the specific number 
of responses that are required. For science, some questions will not let the student move forward or back 
until the required number of responses is selected. Depending on the question, an orange warning box will 
appear if students try to select too many options. However, a warning box will not appear if students select 
too few options, so it is important that students read the directions carefully.

To remove an answer selection, students select the checkbox again.

Number Line (Mathematics Grades 8 and 11 Only)

Number line questions are answered by selecting a type of solution set and then moving the endpoints to 
the correct position. Number line questions can include both open- and closed-endpoint answer options.

Some questions allow students to graph more than one solution on the number line. For these questions, 
students select additional solution set types as needed to display their answer. The active (selected) solution 
is in black and the inactive solution is in gray. Note: In the online SRTs, only one solution can be graphed on 
the number line.

Students may need to remove a type of solution before they can select another one by selecting Remove on 
the active solution.

Order

Students answer order questions by dragging the answer options into the correct order. 

To change their answer, students drag an answer choice to another position.

Note: In the online MCAs, for some questions, students can return the answer options back to their original 
order to answer the question and go to the next question. For others, the question will appear to be 
unanswered if the answer options are returned to their original order; students must reorder the answer 
options to answer the question and go to the next question.
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Point Graphs (Mathematics and Science Only)

Point graph questions are answered by plotting one or more points on a graph. 

Students select a location on the graph to plot a point.

To move a point, students select and drag the point they want to move.

To remove a point, students select the point they want to remove.

For some questions, a line or line segment will connect the points the student plotted. Note: In the online 
SRTs, students will practice plotting two points to create a line.

Reading Passage (Reading Only)

In the online SRTs, students will see one Reading Passage (a poem), located in the Passage tab next to the 
Video tab, and one associated question in the “Try It!” section.

In the online MCAs, at the beginning of each reading passage, students will see a screen with the title of the 
passage. Next, students will see a split screen with the passage on the left side of the screen and the 
question and answer choices on the right.

Each reading passage begins with an introductory text box that summarizes the passage and provides 
instructions for students.

Some students will see text sets, or paired passages. Text sets include two reading passages and their 
associated questions. These title pages will contain two passage titles.

Students may need to drag the scrollbar up or down to read the whole passage.

In the online SRTs, text-to-speech (TTS) is available for the reading passage’s associated question. In the 
online MCAs, TTS is not available for any reading content.

Shape Transformation (Mathematics Grades 7 and 11 Only)

Shape Transformation questions are answered by selecting and dragging a shape to the appropriate 
position on the grid.

To change their answer, students move the shape to a different position or drag a different shape onto the 
grid.
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Question Types

Simulations (Science Only)

In the online SRTs, students will see a simulation, located in the Simulation tab next to the Video tab, and 
instructions in the “Try It!” section.

In the online MCAs, at the beginning of each scenario, students will see a screen with the title of the 
scenario. Next, students will see a split screen showing the science scene and the question. The science 
scene is repeated on the left side of the screen and the question and answer choices are shown on the right.

Some science scenarios require students to run a simulated experiment using a Simulation. Some questions 
require using data generated by running the simulation. 

Students choose variables or options using dropdown menus and buttons.

Students can remove a row of data from the table by selecting the trash can icon in the applicable row, and 
they can delete all of the information in the table by selecting the Clear All button or the trash can icon in the 
header row.

Students may repeat the simulation as many times as needed.

Slider (Mathematics and Science Only)

Slider questions are answered by dragging an arrow slider up or down to answer the question.

To change their answer, students drag the arrow slider to a new location.

Solution Set (Mathematics Grade 11 Only)

Students select the Inequality 1 box to graph the first inequality. A large arrow will appear to the right of the 
box when it has been selected. Inside the box, students select the solid or dashed line for the inequality and 
plot two points on the grid. A solid or dashed line will connect the two points.

Students then select the Inequality 2 box to graph the second inequality. Inside the box, students select the 
solid or dashed line for the second inequality and plot two points on the grid. 

To change a line, students select the box representing the line they want to change. On the grid, students 
select or move the point(s) they want to change. 

Next, students select the box labeled Shaded Region and then select a region on the grid to shade. 

To remove the shading, students must first ensure the box labeled Shaded Region is selected. A large arrow 
will appear to the right of the box. Then students select the shaded region.
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Question Types

Table Grid

Some table grid questions are answered by selecting one or more answers in each row or column. Students 
should select all of the answers that they think are correct. These questions have a square checkbox for 
each answer choice. To remove an answer, students select the square checkbox again.

Other table grid questions are answered by selecting only one answer in each row or column. These 
questions have a circle for each answer choice. To change their answer, students select a different circle.

Tabs (Science Only)

For Science MCA-IV, the stimuli will be based on phenomena, which are observable events occurring in the 
universe that can be explained or predicted with scientific reasoning. The text, graphics, animations, or 
simulations included in the phenomena will be used to provide context for the student to engage in the 
questions.

For MCA-IV, the questions will be organized within phenomena instead of scenarios. Students will see a split 
screen showing the science phenomenon and question. The left side of the screen will display the 
phenomenon, while the question and answer choice(s) are shown on the right. Phenomena may be shown 
on multiple tabs. Students must select each tab to view the full phenomenon.

Students may need to drag the scrollbar up or down to see the whole tab or question.

The tab that appears with the question usually has all the information students need to answer the 
question. Students can use text-to-speech to listen to the information on this tab. Occasionally, a question 
will ask a student to view information on other tabs in order to determine an answer. However, text-to-
speech is only available on the tab that first appears next to the question.
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Question Types

Video Player (Science Only)

Some science scenarios include a video player. Students select Play to start the video. 

Students have the option to pause the video, and it can be replayed as needed.

Students can adjust the speed and volume of the video. Closed captioning is available for students who wish 
to use it; students must select the gear or the Closed Captions (“CC”) button, and then select “English” to turn 
it on. Students can customize the appearance of closed captions by selecting “Settings.” Once closed 
captioning is turned on, it will remain on for all subsequent videos.

The following keyboard shortcuts can be used with the video player:

· “C” key – toggles closed captioning on or off
· “M” key – mute or unmute video volume
· Space bar/“Enter” key – pause or play video
· Down/up arrows – decrease or increase volume in 10% increments
· Left/right arrows – seek forward or backward in the video in 5-second increments
· 0–9 keys – fast seek to a certain percentage of the video

Note: In the online SRTs, the video player does not have the closed captions option in Settings because the 
video lessons have embedded closed captions.

Test Supports Tutorials

The test supports tutorials provide educators and students with information on the purpose and functionality of 
the various test supports that are available on the MCAs. Educators can familiarize themselves with the tutorials 
in the Test Supports and Accommodations section of the online SRTs (PearsonAccess Next > Preparing for Testing 
> Student Readiness Tools > Online SRTs) before using the SRTs with students.

The test supports are available to all students throughout the entire test, and students can access the test 
supports from the user dropdown menu. However, not all supports may be needed or appropriate for all 
students, and educators should ensure that students who use specific supports during instruction know how to 
use them during testing.

Test Supports

Answer Masking

Answer masking allows students to cover all answer options and then uncover one option at a time. This 
support is available only for multiple choice and multiple response questions.

To use this tool, students select Enable Answer Masking from the user dropdown menu.

To show a masked answer, students select the “eye” button to the right of the answer option.

To cover the answer choice, students select the “eye” button again.

To close answer masking, students go back to the user dropdown menu and select Disable Answer Masking.

http://minnesota.pearsonaccessnext.com/readiness-tools/
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Test Supports

Color Contrast

Color contrast settings give students the option to change the color of the screen and words. The default, 
Black on White, uses black text on a white background. Color contrast is also available on start screens, 
welcome pages, and end of group/section screens.

To use this test support, students:

· Select Change the background and foreground color from the user dropdown menu. 
· Select a color choice.

o Black on White (Default)
o Black on Cream
o Black on Light Blue
o Black on Light Magenta
o White on Black
o Yellow on Blue
o Gray on Green

· Select Continue.

Note: If students try to open the color contrast tool while text-to-speech is playing, the read-aloud will stop.

Line Reader Mask

The line reader mask helps students focus on one part of a question, reading passage, or science scene at a 
time. 

To use this test support, students: 

· Select Show Line Reader Mask from the user dropdown menu.
· Select and drag the line reader mask over the question, reading passage, or science scene.
· Select and drag the bottom right corner of the mask to change the size of the mask.
· Select and drag the bottom right corner of the window to change the size of the window.
· Select and drag the arrow icon to change the position of the window within the mask.

To close the line reader mask, students go back to the dropdown menu and select Hide Line Reader Mask.
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Test Supports

Magnifier 1 and Magnifier 2

The magnifier allows students to enlarge portions of the testing screen for better readability.

To use this tool, students select Enable Magnifier from the user dropdown menu and drag the magnifier 
over the area they want to make larger. To close it, students go back to the user dropdown menu and select 
Disable Magnifier. 

The following notes include details about how the magnifier tool interacts with other tools:

· Students must move the magnifier tool away from an answer option before using the pointer tool 
to select their answer. 

· The magnifier tool does not magnify the calculator. If students open both the calculator and the 
magnifier, then move the magnifier over the calculator, the magnifier will not recognize the 
calculator.

· The magnifier tool does not magnify the video player. If students move the magnifier over the 
video player, the magnifier will not recognize the video player.

· If students enable the color contrast tool after the magnifier tool, the magnifier will automatically 
close. After changing the color contrast, students will need to re-open the magnifier. 

· Enabling the magnifier tool while playing text-to-speech on iPads can cause issues with the audio.
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Test Supports

Text-to-Speech (Standard) 

Students can use the text-to-speech tool to listen to the directions at the beginning of each test for all 
subjects. For mathematics and science, students can also use the text-to-speech tool to listen to text in the 
test. 

The Play Text-to-Speech button lets students start and stop the read-aloud. As the text is read, the 
sentence is highlighted in yellow and each word is highlighted in blue as it is spoken. 

The Toggle Click-to-Hear button lets students select the sentence where the read-aloud will begin.

The Jump Back and Skip Ahead buttons let students easily jump back or skip ahead in the read-
aloud. 

The Text-to-Speech Settings button lets students change how fast the text is read by using the plus and 
minus speed buttons. On some devices, it also lets students change the volume. On iPads, the volume can 
be adjusted on the outside of the device, so students will not see the volume control with the other settings. 

Notes:

· For most devices, the Jump Back button lets students jump back to the start of a sentence or a 
previous sentence. 

· If a student uses Toggle Click-to-Hear on an answer choice, it will be selected as their answer. 
Be sure that students are aware of this so that during the test, they review their answer before 
going to the next question.

· If students open the color contrast tool while text-to-speech is playing, the read-aloud will stop. 
Students should change the color contrast, as needed, before starting the text-to-speech.

· Enabling the magnifier while playing text-to-speech on iPads can cause issues with the audio.
· Refer to the Accommodated Text-to-Speech Tutorials section of this guide for information about 

accommodated text-to-speech.
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Test Supports

Zoom (Mac, PC, and Touchscreen)

Students can Zoom in and out to make the entire screen larger or smaller. 

· On Chromebooks and some computers, students press CTRL and the plus sign (+) at the same time 
to zoom in. Students press CTRL and the minus sign (-) to zoom out. Students press CTRL and zero 
(0) to reset the screen to its original size (100%).

· On Macs, students press CMD and the plus sign (+) at the same time to zoom in. Students press 
CMD and the minus sign (-) to zoom out. Students press CMD and zero (0) to reset the screen to its 
original size (100%).

· On touchscreens, students pinch to zoom in and out.

Depending on the device, if students zoom in more than 250%: 

· Tools may appear in the Menu . 
· The Review and Bookmark buttons may also appear in the Menu. 
· Students will need to select the Menu to view all tools. 
· The text-to-speech buttons may appear along the bottom.

Also, depending on how much students zoom in, some graphics and text on the screen may not be visible, 
and students may be unable to answer the question or use the other tools. Instruct students to zoom out if 
this occurs.
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Pop-up Translations Tutorials

The pop-up translations tutorials provide educators and students with information on the purpose and 
functionality of pop-up translations that are available. These translations may provide support to multilingual 
learners, including English learners, former English learners, or students in immersion or dual language 
programs. Educators can familiarize themselves with the tutorials in the Test Supports and Accommodations 
section of the online SRTs (PearsonAccess Next > Preparing for Testing > Student Readiness Tools > Online SRTs) 
before using the SRTs with students.

Language

Hmong, Spanish, and Somali

Eligible students can use the word-to-word pop-up translations to view words translated in Hmong, Somali, 
or Spanish. As determined by the district, this support is available for English learners, former English 
learners, or students in immersion or dual language programs.

Students select a word with a dotted line under it to see it translated.

· On PCs, Chromebooks, or Macs, students use the mouse or touchpad to select an underlined word 
to see it translated. The pop-up will stay open until the student moves away from the underlined 
word.  

· On touchscreens, students touch an underlined word to see it translated. The pop-up will stay open 
until the student touches anywhere else on the screen. 

Note: When students select an underlined word in an answer choice, that choice will not be selected as their 
answer. However, if a student selects any part of the answer choice that is not underlined, that choice will be 
selected as their answer, which may not be the answer the student intended to select. Be sure that students 
are aware of this so that during the test, they review their answer before going to the next question.

http://minnesota.pearsonaccessnext.com/readiness-tools/
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Accommodated Text-to-Speech Tutorials

The accommodated text-to-speech tutorials provide educators and students with information on the purpose and 
functionality of text-to-speech accommodations that are available to students with an IEP or 504 plan. Each 
individual student’s needs must be taken into account when determining which version of text-to-speech 
(standard or accommodated) will be the most beneficial for them. Educators can familiarize themselves with the 
tutorials in the Test Supports and Accommodations section of the online SRTs (PearsonAccess Next > Preparing 
for Testing > Student Readiness Tools > Online SRTs) before using the SRTs with students.

Accommodated Text-to-Speech

Accommodated Text-to-Speech

For accommodated text-to-speech, graphics and tables have text-to-speech available in addition to the audio 
that is provided for standard text-to-speech.

Accommodated text-to-speech is available only for students with an IEP or 504 plan.

In the online SRTs, the accommodated text-to-speech tutorials include select questions from the grade-level 
SRT tutorials but with accommodated, rather than standard, text-to-speech applied. Additionally, all tutorial 
videos, except the text-to-speech tutorial video, have been removed so students can focus on the 
functionality of accommodated text-to-speech rather than on the functionality of the question type. If 
students need information about the question type, please refer to the full tutorial in the applicable grade-
level SRT.

http://minnesota.pearsonaccessnext.com/readiness-tools/
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Science Script Read-Aloud Tutorials

The science script read-aloud tutorials provide educators and students the opportunity to practice administering 
and taking the online assessment in conjunction with a script, an accommodation for Science MCA only that is 
available to students with an IEP or 504 plan. Each individual student’s needs must be taken into account when 
determining if this accommodation will be beneficial for them. Educators can familiarize themselves with the 
tutorials in the Test Supports and Accommodations section of the online SRTs (PearsonAccess Next > Preparing 
for Testing > Student Readiness Tools > Online SRTs > Test Supports and Accommodations > Science Script Read-
Aloud) before using the SRTs with students. Scripts for each grade level can be accessed on PearsonAccess Next 
(PearsonAccess Next > Preparing for Testing > Student Readiness Tools > Paper SRTs), but the content of the 
science script read-aloud tutorials is the same for all grades.

Note: Because the online Mathematics MCA is adaptive and the test items presented vary by student, the script 
must be administered with a paper test book (regular print, large print, or braille). For Science MCA, if a student 
requires a paper test book, the script can also be used with a paper test book. To prepare educators and students 
for administration of a script with a paper test book, refer to the paper SRTs (PearsonAccess Next > Preparing for 
Testing > Student Readiness Tools > Paper SRTs). 

Script Accommodation

Eligible students can take the online science test while a Test Monitor reads aloud the test content using a 
script. Similar to Accommodated Text-to-Speech, graphics and tables, in addition to the test content read by 
standard text-to-speech, are read aloud.

Scripts are available only for students with an IEP or 504 plan.

In the online SRTs, the science script read-aloud tutorials contain the questions from the accommodated 
text-to-speech tutorials but with the text-to-speech video lesson and “Try It!” section removed.

http://minnesota.pearsonaccessnext.com/readiness-tools/
http://minnesota.pearsonaccessnext.com/readiness-tools/
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